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Preface
About this Guide
This user guide is intended for customers and partners of Panduit who have already
received training on the MapSense application from a Panduit Customer Support trainer
or Panduit Professional Services representative.

Readers should have:

l A thorough knowledge of the physical and technical aspects of the data center
l Access to the MapSense Component Library
l Experience using applications on the Web
l Experience using the Microsoft Windows environment

Organization
This guide is divided into chapters based on the tasks typically performed during setup
and maintenance of a project. The table below lists the sections and their descriptions.

Section Description
Introduction Provides information about system requirements, installation, and the user

interface.
Working
with

Projects

Provides information about the tasks required to setup and maintain a
MapSense project.

Power
Monitoring

Covers activities related to setting up power monitoring for the data center.

PUE and
Other

Calculations

Covers activities for setting up PUE and other complex calculations within
MapSense.
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Introduction

This section provides information about system requirements, installation, and the user
interface.

l About MapSense
l MapSense Installation
l Minimum System Requirements
l MapSense User Interface

About MapSense
SynapSense® MapSense is the configuration tool used to map the physical deployment
of sensors installed on the actual data center hardware. MapSense uses a variety of com-
ponents to represent actual data center equipment. For example, sensor nodes are rep-
resented by sensor components such as rack components and Gateways. Logical
concepts and mathematical concepts used for collecting and reporting data are rep-
resented by calculation components such as math operations or PUE calculation com-
ponents.

In MapSense, these components represent the floor plan of the data center and specify
the different types of monitoring installed in the data center, including:

l Environmental (temperature, pressure, humidity, dew point)
l Power and Energy
l PUE
l Active Control (purchased separately - see your Panduit representative)

This MapSense representation of the data center is saved and exported to the Syn-
apSense Web Console, which displays data coming from the actual sensors. Data used
in generated images, tables, and charts are initially configured in MapSense

At a high level, the three main steps for creation and use of a project are:

l Planning and Assessment – Panduit Professional Services generally performs
these tasks for our customers. They include:

l Using a blank canvas to create a drawing or creating a background image
from a customer provided schematic

l Creating a project
l Placing, sizing, and associating components
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All of this creates a project plan by which the team can assess the number and pos-
itioning of SynapSense hardware required for instrumenting the data center.

l Installing Hardware and Obtaining MAC IDs – After the project plan is agreed
upon, and the hardware is ordered and installed, sensor and hardware MAC IDs
are collected and entered into MapSense.

l Project Validation and Export to Web Console – Perform project validation and
export the project to the Web Console where the data from the installed sensors
can be viewed and monitored in real time.

You should update your project plan in MapSense anytime something in the physical
data center environment changes.

MapSense Installation
MapSense is included in the SynapSense Installation CD. The installation wizard
guides you through the steps required to complete the installation.

Minimum System Requirements
The following minimum specifications must be met prior to installation of MapSense.

Hardware Requirements

l Processor – 2 GHz, 32 or 64-bit processor or better
l Memory – 2 GB RAM or more
l Disk Space – 100 GB or more

Software Requirements

l Operating System – Windows SynapSoft 2008 R2, Windows SynapSoft 2012 R2,
and Windows SynapSoft 2016

l Software – Java Development Kit (JDK) version 8 – Included with the SynapSense
installer.

l User Privileges – The user installing the software must be logged in with Admin-
istrator privileges before installing MapSense.

MapSense User Interface
The MapSense user interface incorporates standard point-and-click functionality for com-
ponent placement and drawing management.
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1. Menu Bar – Standard Windows-type drop-down menus display.

2. Toolbars – Quick access buttons for frequently used tasks like saving a project
and selecting a component.

Toolbar Icons

Icon Description Icon Description
New Project Zoom In

Open from Disk Zoom 1:1

Save Zoom Out

Load Component Library Zoom to Fit

Change User Level Validate Project

Set Background Scale Sync with SynapSoft

Reload Background Image Export Deployment Plan to PNG

Undo View Options

Redo View Stats
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Icon Description Icon Description
Find User Guide

Assign MAC ID Copy Settings

Select Add Drawing

Rotate Object Show/Hide Palette

Associate Show/Hide Properties Panel

Quick Name

Display Filters – Select or Deselect Filters

Filter Description
Environmentals

Power and Energy

PUE

Contained Area

3. Component Palette – Provides the currently active data source and grouping, the
ability to filter the component list by current project, active project, and tags. Click
Tags to open a list and select the type of components to display. With none of the
buttons selected, type a search term in the field to display just components con-
taining that key word. See also About the Component Palette.

4. Workspace – Area in which the drawing displays and the work is done to place
components.

5. Data Sources and Groupings – Displays a list of components in each room, cal-
culation group, region, or network in a tree hierarchy. Users have access to the ver-
tical quick access icons for adding and removing data sources.

6. Properties Editor – When an item is selected on the drawing or on one of the tabs
above, the editor displays the properties for that item. When more than one item is
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selected, the editor displays the properties that are common to all, leaving prop-
erties blank that the items do not share.

7. Status Bar – Displays messages, the Zoom Factor, the cursor position on the x/y
axis, and the current User Level.
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Working with Projects

This chapter provides information about the tasks required to setup and maintain a
MapSense project.

In this chapter:

l Creating a New Project
l Additional Configuration Tasks
l Maintaining an Existing Project

Creating a New Project
MapSense requires several configuration steps before an installation is complete and
sensors can begin reporting data. This section explains the steps required to create and
configure a MapSense project and to export the final project file to the SynapSense
Environment Server.

l New Project Checklist
l Open a New Project
l Set Scale for Background Image
l Set Options
l Create Data Source
l Background Images
l Using the Canvas
l Create Rooms
l Select and Place Components
l Planning Groups
l Size Racks
l Name Components
l Specify Location
l Assign MAC IDs
l Adding Associations
l Validate Project
l Export to SynapSense Environment SynapSoft
l Working with Multiple Floor Plans in a Project
l Considerations for Multiple Data Centers
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New Project Checklist
A new SynapSense project requires preparation, planning, and configuration, prior to
hardware installation and project validation. The checklist provided here should help to
ensure that all of the steps are completed in the set order for a successful product
implementation. Please contact your Panduit representatives with any questions
concerning this process.

Preparation
There are three options for preparing a new project to be used in Web Console:

1. Obtain or create a background image with transparency layer in Portable Network
Graphic (.png) format for each floor, room, roof, or virtual floor covered by the
project file.

2. Obtain a background image with or without a transparency layer to use as a tem-
plate for manually creating the drawing. When the drawing is done, you can delete
the template.

3. Manually create a drawing from a blank Canvas. See Using the Canvas for details.

Planning and Configuration

l Open a new project
l Change the user level
l Using the Canvas
l Set the scale
l Set options
l Create data sources, including Wireless Sensor Networks
l Create rooms
l Select and place components
l Size Racks
l Copy Components
l Adding Associations
l Name Components

Hardware Installation and MAC ID Assignment

l Specify location of the physical hardware and assign MAC ID
l Adjust project details, as required
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Background Image
See Background Images for details.

Project Validation and Export

l Save the project
l Validate Project
l Export the project file to the SynapSense Environment Server

Once the project is created, there are a number of optional tasks you can perform. See
Additional Configuration Tasks or Maintaining an Existing Project for more information.

Note: You must export a MapSense project file before the SynapSense platform is
operational. An error displays in Web Console indicating configuration is not complete
if the MapSense project file is absent.

WARNING! Immediately upon opening a file, MapSense creates a backup file in
the same directory. The backup file has the extension of .bak. If a .bak file already exists
with that name, it is overwritten. This file can be used to recover from inadvertent
changes that have been saved, but not exported. Once an export has been done, this
backup file is no longer in sync.

Open a New Project
The first step in opening a new project entails creating and naming a file and selecting
the drawing with which to work.

To open a new project in MapSense:

1. On the File menu, select New Project. The Add Drawing dialog box displays.



MapSense User Manual

- 15 -

2. Enter a name for this project. Select the Use Background Image check box if
desired. Then click OK.

3. The Select Background Image dialog box displays if you chose to use one.
Navigate to the png file prepared with a transparency layer for use in MapSense. If
there are multiple floors or rooms in this project, items will display in alphanumeric
order.

4. Click Open.

5. Save the new project and give it a name.
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MapSense creates several drawing view images for exporting in the project file, one for
the entire data center and one for each room. If necessary, each image is scaled to fit a
2879 x 2878 area. The SynapSense Web Console scales the image again, as needed,
for display on the server. Therefore, for best (clearest) viewing, use a background image
with the largest room pixel dimensions of approximately the same size as the display-
resolution of the server. For example, if all monitors are 1024 x 768 pixels, design the
background image so the largest room will be approximately 1024 pixels wide.

Change the User Level
MapSense has two user levels: Advanced and Expert.

l Advanced – This default user level can create and design projects and place
components, as well as export projects to the SynapSense Environment Server.

l Expert – This user level is primarily for the use of Panduit technicians. Only use
this level at the express direction of Panduit Technical Support or your Panduit
technician.

To change the user level:

1. On the Projectmenu, select Change User Level.
2. Select the Access Level from the drop-down list.
3. When elevating the access level, enter the Access Code. The default access code

is 1234. Panduit highly recommends that you change the default.When lowering
the access level to Advanced, no Access Code is required.

4. Click OK.

Access codes are local to the machine. To open a MapSense project file on another
machine, use the access codes for that machine. If none was set, use the default.

Set Scale for Background Image
Scale is used to determine the distance between sensor components. The Scale para-
meter can be a close approximation, although precise measurement is preferred. If the
scale of the background image changes after components are placed on the drawing,
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the component size and relative locations adjust. Changing scale does not change the
size or quality of the background image.

To set the scale parameter (Project menu method):

1. Find something on the drawing image for which you know the width. For example,
floor tiles and racks are usually two (2) feet wide.

2. On the Projectmenu, select Set Background Scale.

3. Place the cross hair that displays at one edge of the object you selected in Step 1
and click once.

4. Move the cursor to the other side of the object and click again. A black line
displays between the two points.

Tip: The scale's accuracy increases as the line you draw gets longer. Pick
and enter larger distances, such as drawing across multiple floor tiles.

5. In the Input dialog, enter the distance between the two points, then click OK.

Find the Scale in inches per pixel in the Properties Editor panel to the right of the
workspace.

Note: Whenever a new background image is loaded for a project, set the scale
parameter again to adjust the size and relative position of the components to the new
image.

To set the scale parameter (Groupings tab method):
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1. Click the Groupings tab.

2. Select the drawing. Its properties display in the Properties Editor panel.

3. Set the Scale property value in inches per pixel, as shown below.

For example, if the background image is 3000 pixels wide and represents a distance in
the data center of 80.3 feet, then set the Scale value to 0.3212, indicating that each
screen pixel represents about one third of an inch in the actual data center.

Set Data Center Elevation
To ensure accurate pressure readings, always set the Elevation for every data center in
the project. The pressure variations based on elevation are measurable enough that an
accurate elevation of a data center is necessary. Elevation is the vertical distance
between the local surface of the Earth and global sea level. The local surface of the
Earth will be either land or water surface.

In a typical raised floor data center, the ideal pressure is .035-040 inches of water
(inH2O). At 0 feet elevation, true .035 inH2Owould read as .033 inH2O, while at ~5000
feet (1500 meters) of elevation, the pressure would read as .040 inH2O. Without the cor-
rect elevation entered, the pressure will have an error of -5% at sea level and +15% at
1500 meters. This degree of variation is enough that it affects SynapSense's manual bal-
ancing service, which relies on accurate pressure readings.

To determine a data center's elevation, consult http://www.whatismyelevation.com.

Note: For an installation in a high floor of a tall building, consider the height of that
floor. For example, an installation on a 15th floor would add 200-300 feet to the base
site elevation.

http://www.whatismyelevation.com/
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Set Options
MapSense allows the IP address of the SynapSense Environment Server and the unit
system to be configured for each project file. There may be instances where you will
need to change the default settings.

To set general configuration options:

1. On the Projectmenu, select Project Options.

2. Use the following guidelines to complete the fields on the General Configuration
Options dialog.

l Environment SynapSoft Host IP – In most cases, MapSense is installed on the
same machine as the Environment Server. In this case, leave the field as the
default “localhost”. If MapSense is installed on a different machine, enter the IP
address of the Environment Server in this text box field before exporting the
project.

l Control Process Test URI – This is used for testing expressions in Generic
Controlled Devices. If the data center contains no Generic Controlled Devices,
leave this field blank.

l Generated Background Fade - If you choose not to include a background image
with a MapSense project, when the project is exported to the Environmental Syn-
apSoft, it displays as slightly faded in Web Console, so that the icons that lay on
top of the background image are more visible. This option allows you to change
the level of fading on a sliding scale between no fade and maximum fade. You can
then click Test Background Fade to preview what your change will look like.

l Units – Select the unit of measurement to use while creating this MapSense
project. The selection does not affect the units of measure displayed in the Web
Console.

l Test Background Fade - Click this option to see a preview of the generated back-
ground with the fade level you selected.

3. When finished, click OK.
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Create Data Source
Before placing components on the drawing, you must create at least one data source. A
data source is the type of network on which SynapSense operates. Currently, there are
five data source types available for use.

Wireless Sensor Network (WSN) – A network made up of wireless components that
conform to a single PAN ID. This is the most commonly used data source. A WSN net-
work requires at least one Gateway, but may have more than one. Even a small network
may have more than one Gateway for redundancy, and in some cases additional Gate-
ways are added to increase the speed of collecting data from networks with a large
number  of nodes.

Modbus TCP Network – A network that allows the system to communicate with Mod-
bus devices via the Modbus TCP protocol. Devices that use Modbus TCP natively can
be configured as the data source in a Modbus TCP Network. Devices that use another
variant of Modbus (such as Modbus RTU) require a Modbus TCP gateway. For these
deployments, the Modbus TCP gateway should be configured as the Data Source.

Note: A Modbus Integrator's Read Length property is the number of registers read in a
single Modbus request. It is used for devices that require 32-bit values to be read in
pairs of registers and don't return values when the registers are read in 2 separate
requests. An example of the "block read" lock is the Eaton PONI device for electrical
sub-stations.

SNMP – Integrates with equipment using SNMP for reporting. MapSense provides
agents for SNMP version 1, 2c, and 3.

Note: SNMP Data Type "Integer32" is a signed 32-bit value.

BACnet Network – Allows the system to interface with devices that communicate
via BACnet IP protocol.

Web Service Host – Reads a specific value from a specific XML document. It
enables you to pull a single value from a URL-addressable XML file.
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Adding a Data Source
The process of adding a Data Source is similar for all of the Data Source types. Wireless
Sensor Networks require more detailed configuration. Adding a WSN network is covered
in the next section.

To add a Data Source:

1. Do one of the following:

l Select the data source type you want from the Data Sources menu.
l With the Data Sources tab selected, click one of the icons on the ver-
tical toolbar located on the right of the Data Sources/Groupings tabs.

2. When the Add Data Source dialog displays, give it a unique name, then click OK.

3. Once added, click the new data source on the Data Sources tab to display its
properties.

4. In the Properties Editor panel, configure the properties listed for that Data Source
type. Each type of data source requires a different configuration.

5. Repeat this process to add more data sources.

6. When finished, save the project.

To move a component between data sources:

1. Click and drag existing components in a Data Source between Data Sources of
the same type. All other properties of the item are retained after the move.

To remove a data source:

1. Highlight the item, then click the icon on the vertical toolbar.

WARNING! Removing a data source will also remove all components under that
data source.

Adding a WSN Network
Wireless Sensor Networks are the most commonly used network type in SynapSense
Wireless Monitoring and Cooling Control. WSN uses PAN IDs, which are the unique
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identifier that allows network nodes to begin communicating (join) with that network. The
PAN ID is a four-character, hexadecimal number that is similar to the SSID in a Wi-Fi
network. Nodes that have a different PAN ID from the specified network cannot send or
receive data on the network.

The PAN ID is assigned to a node when it joins the network. Nodes are not allowed to
join the network if their MAC ID is not listed for that particular WSN Network. Under the
Data Sources tab, a WSN Network node will have child nodes for all gateways and
sensors belonging to that particular network. Gateways and sensors under a WSN Net-
work node are assigned its PAN ID. For new WSN Data Sources, the PAN ID is
automatically assigned when the network is created.

Note: A default WSN Network will be created automatically if one does not exist when
a component is first placed on the drawing.

To add a WSN network:

1. On the Data Sources tab, select Add WSN Network.

2. Enter a name for this network and click OK.

3. On the Data Sources tab, click to highlight the name of the WSN Data Source and
display the network properties.

4. In the Properties Editor, review the information displayed and make any necessary
changes.
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5. Save the project. The next step is to set up the rooms in the data center.

Background Images
An optional background image can be used to create a project of any size in MapSense.
If the data center facility to be instrumented with SynapSense products is one room, then
one background image can be used. If the facility has multiple floors in a building or
includes a utility room, then a background image would be used for each one.

The format required is:

l Portable Network Graphic (png) with transparency layer for LiveImaging
l JPEG File Interchange Format (jpg), if LiveImaging is not used

Architectural drawings or AutoCAD®-type drawings are recommended but Visio® or
another type of drawing to scale works too. If your facility can provide a CAD drawing
and you choose to use a transparency layer with it, ask for or apply a vector trans-
parency layer to the area of the floor plan where the SynapSense sensors are mounted.
This allows the LiveImaging to display. Photoshop™ and other graphics programs also
have this capability to add the transparency layer. If none of these programs is available,
try the freeware product described in Appendix B, and follow the instructions provided,
for adding a transparency layer to the floor plan image.

The exception to this rule is adding a PUE graph or other information that is essentially
an overlay of a physical floor plan. See Working with Multiple Floor Plans in a Project for
additional information.

Note: The maximum size for background images is 67,108,864 total pixels. This uses
268 MB of memory.

Changing a Background Image
Because data centers change often, there is a specific menu option to reload the
background image. If you are manually drawing a room on a blank canvas, you may
want to go back to using a loaded image or add a loaded image to serve as a temporary
template.

Note: When using a background image, it is important to have the transparency layer
added to the background image before loading it into the project. See Appendix B
Create Background Images for instructions on how to add transparent areas to a back-
ground image. Transparent areas allow LiveImaging to display once they are added.
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To reload the background image:

1. On the Project menu,select Reload Background Image.
2. Select the drawing to load.
3. Export the newly edited project to update the system database.

Note: If the drawing is a different size from the original, reset the background scale or
adjust the location of the components. See Set Scale for Background Image for details.
If the updated drawing has the same scale as the original, there is no need to reset the
background scale.

Removing the Background Image
If you use a background image as a temporary template to use while manually drawing a
room on a blank canvas, you will want to remove the background image before export-
ing. To permanently remove the background image from the project, perform the fol-
lowing steps.

1. Click Project and select Remove Background Image from the drop-down menu.
2. In the dialog box, select Yes. As a result, your canvas is transparent, while all com-

ponents you have placed on the canvas are opaque.
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Using the Canvas
When you add a drawing and choose not to use a background image, you will create
your drawing on a blank canvas. If you use a background image as a template and then
remove the template, the canvas size will default to the same size as the image it is repla-
cing. When a new drawing is created with no template image, the canvas will default to a
system-configurable size, initially 1800x1200 pixels to match the ideal size for Web Con-
sole and Live Imaging.

To change the size of the blank drawing canvas, perform the following steps after cre-
ating a new drawing with a blank canvas.

1. Click Project and select Set Canvas Size from the drop-down menu. The Set Can-
vas Size dialog displays, with the default values of 1800x1200 pixels.

2. You may click Best Fit to automatically set the size to the smallest height and
width that will contain all the components, along with a configurable border. Or you
can enter new pixel values for theWidth and Height.

3. Click OK.

The maximum image size limitations MapSense enforces for loaded images are also
enforced for the drawing canvas.

If a drawing canvas is used, MapSense will generate a background image using the can-
vas and the components as seen on the MapSense drawing. The canvas background
will be automatically set to transparent inside of rooms with environmental nodes. Floor
tile grids and component images are then drawn on top of the canvas as opaque items.

Uninstrumented Components
MapSense now allows you to model components that are not instrumented. At the Com-
ponents Tree, you can filter on these components by performing the following steps.
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1. Click the icon
2. In the Filter by Tags dialog box, click Clear All.
3. Select the Drawing Shapes check box and then click OK.

Only the Drawing Shapes display in the Components Tree.
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Create Rooms
A Room is a polygon component added to the project to represent the physical bound-
aries of the rooms in a data center. A Room defines a single contiguous, confined air-
space bounded by walls or partitions.

Note: As you create the room, make sure to model all airflow-restricting partitions. Fail-
ure to do so will cause LiveImaging and Active Control to perform incorrectly.

A Room is not limited to containing only SynapSense components. It can be used to
draw any part of a drawing that the user wants to see in the Web Console. All com-
ponents inside of the Room boundaries are children of that Room. Rooms may be inside
of another Room, but are not allowed to overlap. Components will be the children of the
inner most Room.

Rooms have optional properties that allow you to model floor tiles in a raised floor room.
(The View/Toggle Grid View option in previous versions of MapSense has been
replaced by View/Toggle Floor Tiles.) To specify a Raised Floor, select Raised Floor
from the Room Type property drop-down menu. This allows you to model tiles without
using a background image.

Room Types

For a Slab room type, the Control Type options are None or Remote Control.
For a Raised Floor room type, the Control Type options are:

l None
l CRAH Pressure
l CRAH Pressure and Temperature
l DX Temperature
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The validations of the CRAC Component are the same as those for the CRAH com-
ponent, with the following addition:

l Both the Air Volume Table (or the Max CFM field for non-VFD CRACs) and the
Sensible Cooling Table are required.

The room's Control Type automatically applies the correct device objects to the Cooling
Unit components.

To move objects within groupings:

1. Right-click on an object and select Change Groupings in the context menu.
2. In the Change Groupings dialog, select the radio button for the group where this

object belongs.
3. Click OK.

To add a room within a room:
1. In Components pane, type room in the filter text box to display the Room com-

ponent.

2. Single-click the room icon.
3. Click the place where the first corner of the new room is located, and then move

the cursor to the second corner. MapSense will display the dashed line. Repeat
this for the other corners of the room.
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4. To complete the room, you can either click on the first corner to complete the last
line or right-click to auto-complete the last line. The new room will be highlighted in
a red outline.
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5. At the Groupings tab, click the Name field's Values box to name the room. Make
any other necessary changes to the properties necessary and save.
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To change the room, you may:

l Drag the corner dots to a new location
l Right-click a corner dot and remove it
l Right-click on the line to add another dot, and then drag it to where you want it

To display room properties:
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Highlight the Room name on the Groupings tab to view the properties for that room in the
Properties Editor panel. Once assigned, a room requires no further configuration.
However, room properties can be adjusted.

Place components into the rooms you created. You may move them within the drawing.
They will automatically be reassigned to the inner-most room when they are moved.

Room Properties Definitions
l Border Pixels default to “10”, but can be increased or decreased (to a minimum of
0). This parameter represents the amount of additional space included outside the
rectangle used for the drawing in the Web Console. MapSense trims the rectangle
to include only the components in a room. The default value of “10” adds an
additional 10 pixels in each direction beyond the rectangle that includes all of the
components in that room.

l The amount of LI Border Pixels determines how much area beyond the room’s
rectangle is included in LiveImaging. It only includes the sensor node components
in a room.

Note: Border pixel settings are additive. Therefore, if you set the Border
Pixels to 10 and the LiveImaging Border Pixels to 10, the result would be a
20-pixel border.

l The Name property is displayed in the Site list in the Web Console. It can be
changed any time after a room is created.
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l The Description is used in the tooltip on the Sites list in the Web Console. This is
optional information.

l The Gross Area is the area of the entire selected room (including inner rooms) in
Square Feet or Square Meters. The Net area is the area of the room minus any
internal rooms.

Select and Place Components
Placing components on the drawing is the main task in MapSense. In this section, learn
to place, edit, align, distribute, or change the order of components on a drawing that
represent the physical components in the data center.

About the Component Palette

The Component Palette displays the available components in MapSense. Additional
Component Libraries, when loaded, also display here.
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Active Data Source and Active Grouping display according to the currently active draw-
ing.

Filters provide for listing only the components used in the current project; only
components allowed in active data source or grouping; only components with selected
tags; and, by the keywords typed in the field. Clear the filters by clicking the X.

Components display as a list by type. Hover over the components to read the complete
tooltip description of the item. Refer to the Component Encyclopædia for details about
any of the components.

To place a single component:

1. In the Component Palette, locate the component to place on the drawing.
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2. Click to highlight the component (turns icon blue).

3. Move the cursor to the location on the drawing then click to place the component.

4. Once placed, the cursor resumes Selection mode so you can click other types of
components or perform other activities in MapSense.

Note: Once you place a component into a room, the component automatically asso-
ciates as a child of the room. If you move that component to a different room, the com-
ponent automatically associates with the new room. If a component is not placed in a
room, it will show in the Groupings panel under Not In Room. Anything listed there
must be in a room before deploying the configuration to the SynapSoft.

To place multiple components of the same type:

1. In the Component Palette, double-click a component to activate multiple formatting
mode (turns icon red).

2. Click to place the component as many times as needed on the drawing.

3. When finished, click the Selection tool, on the lower toolbar, to resume selection
mode (turns icon gray).

WSN Components Assignment to a Network

When a component is placed on the drawing that requires a WSN network, MapSense
automatically assigns the component to a WSN network based on its relationship to
WSN Gateway components on the same drawing. If no WSN network exists for the act-
ive drawing, MapSense will create one automatically.

WSN Gateway components will not automatically assign to a network due to their import-
ance to the auto-assignment rules. When placing a WSN Gateway component, you will
be prompted to choose one of the already existing networks or to create a new network.
Adding or moving a gateway may affect the network assignment of other components for
drawings that have more than one network.
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The logic MapSense uses to assign a component to a WSN network is shown in the dia-
gram below.

To manually override the WSN network assignment for a component, perform the fol-
lowing steps.

1. Right-click the component and selectManually Assign to WSN (or other network
type) from the drop-down menu.
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2. In the Change Data Source dialog box, select the desired network and click OK.

3. In the Data Sources tab, the manually assigned component will display with an (M)
before its name. This indicates that the component will not automatically be
assigned to another network even if you move it to a different location.
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If there are multiple WSN Networks in your project, you can reassign or specify which
network a component belongs to as needed (for example, if there is interference
between a component and its nearest gateway). You also can manually override the
WSN Network assignment by dragging the item to a different WSN Network. You can
return to Auto Assign by right-clicking and selecting Automatically Assign to WSN.
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Editing Selected Components

The following tools are available to manipulate selected components. Alignment,
distribution, and change order are available from the Edit menu on the menu bar and
from the context menu for a specific selected component or group of components. The
nudge and scroll lock features are available using the keyboard whenever an object is
selected.

To align components:

1. On the drawing, highlight a group of components.
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2. On the Editmenu, select Align , and then on the submenu, select one of the
options: Align Left, Align Right, Align Top, or Align Bottom. In the image below,
Align Left was selected.

To distribute components horizontally or vertically:
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On the drawing, highlight a group of components. On the Edit menu select Distribute
then on the submenu, select either Distribute Vertical or Distribute Horizontal.

To change component order:

On the drawing, select one or more components. On the Edit menu, select Order then
choose from the submenu options:

l Bring to Front – Bring the selected component to the top (most visible top
position) of the group of components.

l Bring Forward – Brings the selected component up one position in the group of
components.

l Send Backward – Pushes the selected component down one position in the
group of components.

l Send to Back – Pushes the selected component to the bottom (behind all other
items) of the group of components.

Note: Rooms are always placed at the back of the drawing, with contained areas
placed in front of the rooms. This cannot be changed. All other components are in front
of the rooms and contained areas and can be changed.

To nudge a component:

Highlight a component object and use the arrow keys on the keyboard to move the
object by small increments (nudge) in one direction or another.

To move the whole drawing in this way, press Scroll Lock on the keyboard. For example,
when zoomed in on an area of the drawing to make an association, and the component
you need is just out of the visible area. Press Scroll Lock once to activate the feature
then use the arrow keys to nudge the view to include the component you want. Press the
Scroll Lock key again to deactivate the nudge feature.

Copy Components and Settings

Some components, such as the rack component, are placed many times to develop a
drawing in MapSense. Instead of configuring these components individually, you can
copy the settings for the components that are similar.

There are two methods for copying components:

Copying Components— After creating one of each component type, (for example,
sizing and rotating a Rack component) copy and place the component as many times as
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required. Copy the components individually or in groups. This is useful for quickly
populating rows of identically monitored racks.

Copying the Component Settings—Use the Copy Settings tool to copy most of the
settings from a fully configured component (except for name, MAC ID, and x and y
location) to another component. This is useful for designs that have many similar
components.

To copy single or multiple components:

1. Select all of the components to be copied.

2. Select Copy from the Editmenu.

3. Select Paste from the Editmenu. The copied components remain selected.

4. Click and drag the components to the desired location.

To copy component settings:

1. Select the Copy Settings tool on the toolbar.

2. Select the component to be used as a template for the settings.

3. Click to select each of the components to which you want to apply the settings. The
settings automatically apply to the new component.

4. View these newly applied settings in the Properties Editor panel.

Contained Area Components

The Contained Area components give you finer control over LiveImaging beyond what is
available from rooms. When LiveImaging creates images, the temperature data does not
extend beyond the edges of a Contained Area component. For example, if a data center
has hot aisle containment, pressure, and humidity, a Contained Area component could
be placed on the hot aisle. The exhaust- side sensors of the racks on that aisle would be
used to develop LiveImaging inside the contained area and the intake-side sensors
would be used to develop LiveImaging outside the contained area.

There are two types of Contained Area components: polygon and rectangle. Use the
Polygon Component to create an arbitrary shape that can accommodate real-world rack
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sizes. This component shape is helpful for accommodating unusual areas in the data
center.

Optionally, the Contained Rectangle Component creates a rectangle. The Length and
Width properties represent the size of the contained rectangle in inches. This component
shape is helpful for creating basic contained areas over racks or aisles.

The components work in the same manner. A black line on the drawing indicates the
border of the contained area that LiveImaging will not cross. Contained Area
components do not require a Data Source or a Grouping. The icon on the drawing
represents the center of the contained area.

To use the contained polygon components:

1. Place the Contained Polygon component on the drawing.

2. Click the desired set points on the drawing. There is no limit to the amount of
points. Because it is a polygon, the points cannot cross (MapSense displays an
error message if this happens.) The last point is equal to the first, so that it closes
the polygon. Points can be added or removed after the polygon is created, by right
clicking on the polygon to display the context menu.

3. Configure the minimum number of sensors in the Properties Editor panel. By
default, Contained Area Components require a minimum of two sensors located on
each level within the area to calculate data for LiveImaging. If this requirement is
not met, then the area appears as a solid color. Optionally, set the color to be used
to fill the area when the minimum number is not met.

4. Select the appropriate checkboxes in the Properties Editor panel to isolate sensors
on one or more LiveImaging layers. Only the selected layers apply to the contained
component during data calculations.
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In the hot-aisle containment example, the Contained Polygon component is applied only
to the top, middle, and bottom LiveImaging layers, but not to the subfloor.
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Planning Groups
A Planning Group is an optional utility that allows you to logically group components in
MapSense for any reason. A Planning Group provides project statistics and visualization
of the components within the group.

A Planning Group and all of its components can be excluded from export outside of
MapSense. This allows a partial staging of the project without requiring all components
to be fully compliant before exporting the rest of the project. However, to maintain the
integrity of an export, project validation will display an error if any component in a non-
exporting Planning Group group is associated with a component that will export. To
clear the error, do one of the following:

l Remove the component from the Planning Group
l In the Property pane, select the Export Components check box for the Planning
Group

l Remove the association with the component in the Planning Group

Note: If a previously exported component is added to a Planning Group that will not
export, any subsequent updates to that component will not be updated on the Syn-
apSoft during the next export. The previously exported version of the component will
remain on the SynapSoft.

Warning! If a component is in a planning group that is set to NOT export, and the
component is then deleted or replaced with a different type, it will be deleted on the Syn-
apSoft after the next export even though the planning group does not export.

Create a Planning Group
To create a Planning Group, perform the following steps.

1. Click Groupings and select Add Planning Group from the drop-down menu.
2. In the Add Planning Group dialog box, enter a name for the new group and click

OK. The new Planning Group will display next to a icon under the Groupings
tab.
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3. Drag and drop the desired components into the Planning Group, or right-click the
component and select Change Grouping.

4. By default, the Export Components check box is selected in the Properties pane.
To prevent export of the Planning Group components outside of MapSense,
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deselect the check box.
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Configure Racks and Components
Size Racks
The next step in creating a new project is to adjust the size of the racks. It is important to
size the Rack components to be the same as the rack on which they are installed.
LiveImaging uses the cold and hot aisle locations as starting data points for the
extrapolation between the actual data points.

To size a Rack Component:

1. Select the component using the Select tool from the toolbar.

2. Edit Width and Depth in the Properties Editor panel to match the actual rack
dimensions (in inches).

3. Reposition or rotate (see the next section, Rotate Racks) the Rack component as
necessary.

Rotate Racks
To rotate a rack component (Rotation tool method):

1. Select the icon from the toolbar.

2. Click the Rack component and and drag the mouse pointer to the left or right to
rotate the component. The component will rotate as you do this.
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3. Click again when the Rack component is facing in the correct direction.

Another method for rotating racks is to manually set the Rotation property. In the
Properties Editor panel for a rack, enter the appropriate degrees in the Rotation value, as
shown in the table below.

To rotate the rack Enter this value (to indicate degrees)
Facing right 0
Facing up 90
Facing left 180
Facing down 270

Name Components
Each component must have a unique name.

To name a component:

Select a component with the Selection tool and change the name property.

Or double-click directly on a component and change the name displayed beneath the
icon.

Using the Quick Name tool from the toolbar is faster in some circumstances.

1. Select the icon on the toolbar.

2. In the Quick Name Settings dialog, configure up to three variables that
automatically-increment with the placement of each component. See details below.

3. To use these settings, click Close and begin placing components. The Quick
Name tool button remains highlighted.

4. To stop using the Quick Tool, select another button on the toolbar.

To use these settings at another time, click the Quick Name tool button. The settings
remain the same until changed or reset.
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To configure Quick Name settings:

Numeric #1 ($1), Numeric #2 ($2), and Alpha #1 ($3) are variables that increment with
each click (placement) of a component. With each new rack component placement, the
name and numbering increments. The first name will be “Rack 1”; the second “Rack 2”,
and so forth.

Variables can be incremented at different rates and have varying widths. For example,
Rack 01 is width 2. Rack 0001 is width 4. The padding can be different for each variable.
Using the Alpha variable with padding set to “A” and width set to 3 will name racks –
Rack AAA1, Rack AAA2, and so forth.

Specify Location
All components have a Location field that displays in the Web Console. Maintaining this
field in the data center enables faster location of components. For example, using the
Location field can help locate a pressure node placed under server racks in the subfloor.
The Location field can also be included in Alert templates so that the alert message
provides more information.

Assign MAC IDs
MAC IDs are unique, 16 digit, hexadecimal numbers. Each physical sensor node has a
unique MAC ID. The MAC ID property for a component associates that component in
MapSense with a physical sensor node installed in the data center. Without a MAC ID
associated to a component in MapSense, a sensor node configured and turned on within
range of a Gateway cannot join the network.

Note: Components for ThermaNode EZ use a modified EUI 64 ID.
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To enter a MAC ID (Edit Method)

The simplest method for entering a single MAC ID is to select a component and edit the
MAC ID property in the Properties Editor panel. It is important to enter any leading zeros
that are part of the MAC ID. The MAC ID is printed on the bar code label on the physical
sensor node.

To enter a MAC ID (MAC Assign tool method):

1. Select the MAC Assign tool (red and white tag icon on the toolbar).

2. Click the component to which you want to assign the MAC ID. Each component
selected opens a dialog box in which to enter the MAC ID.

3. Scan the bar code on the physical sensor node to be installed at the location of this
component.

Two entry boxes appear for CRAH components; one is for the supply air node, the other
is for the return air node. It will close automatically when finished.

All components must have MAC IDs entered before the project is exported to the system
database. Incorrect MAC IDs are detected through a checksum calculation and generate
a validation warning during export. Use this feature to check the project for bad MAC IDs
prior to physical installation of the sensors in the data center.

Adding Associations
Associations relate a property of one component with another component. For example,
a group of rack components using the subfloor reference temperature of another rack
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component. In this manner, most of the racks will not need to be installed with their own
subfloor thermistors, saving cost and installation complexity.

Association lines are drawn across the drawing from one component to another. Make
associations between two specific components, using the Associate tool, or make
multiple associations using the context menu.

To associate two components (Associate tool):

1. Select the icon on the toolbar.

2. Click the first component.

3. Click the second component to use as a reference temperature.

Note: The best reference temperature is usually the closest subfloor temperature
sensor to the actual rack.

A solid line indicates the association of the two components. Place the mouse on an
association line to highlight it. Continue to associate components until all racks that
require a reference temperature are associated to a component with a subfloor
temperature sensor.

To make multiple associations (context menu):

1. Use the cursor to highlight a group of components.
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2. Right-click to display the context menu then select Associate.

3. Click the component with which you want to associate all of the selected
components. When the line displays connecting the components the operation is
successful.

Editing Associations
When an association line is selected, a dialog box appears to allow removal of existing
associations. This is useful when configuring PUE or power components with many
associations.

To edit an association:

1. Select the Association tool from the toolbar.

2. Click an Association Line to open the Select Association Type dialog.

3. Check or uncheck the associations as desired. Unchecking removes the
association.

4. Click OK.

Association Line Color

Association types are represented in different colors, making them easier to identify in
complex projects. The following table lists the line color set for each displayed
association type.

Association Type Line Color
Environmental
Hover (when cursor hovers over any Association type) Light Blue
Reference Temperature Red
Current Gray
Power Forest Green
Equipment Status Olive
Panel Red
Power Monitoring
Circuit Indigo
Phase Indigo
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Association Type Line Color
Power <-> Env. Bridge Indigo

Pin the Current Hover

Using the cursor, hover over an association line highlights the line in light blue (and
highlights the components on both ends of the line). The line returns to its original
designated color when the cursor moves away from the line.

To pin the association line so it remains highlighted, hover over an association and
press Ctrl+Comma. Then, move away from the link and scroll or zoom to view other
areas of the drawing. This is useful for tracing PUE calculation lines across a large data
center floor plan.

Note: MapSense can zoom in on a drawing up to 20x.

To remove the highlighting of an association line (unpin) press Ctrl + Shift + Comma.
The line returns to its original designated color.

Association View Settings

Several selection options exist for viewing associations.

On the View menu, select View Options to bring up a multi-tab dialog (defaults to the
General tab).
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Use the descriptions below to select how you want to view associations.

l Don’t Highlight Associations on Hover – When selected, hovering over a
component highlights only that component (no association lines).

l Highlight Immediate Associations on Hover – When selected, hovering over a
component highlights all association lines directly connected to that component,
as well as the components on the other end of those lines. Hovering over an
association line highlights only the selected line and the components on either end
of that line.

l Highlight Subgraph on Hover – When selected, hovering over a component
highlights all of the association lines attached to that component and all of the
connected subgraph elements (for example, child components and lines).
Hovering over an association highlights that line, the components on either end of
that line, and all sub graph elements (for example, child components and lines).
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Validate Project
The Validate Project option in the Export menu checks all aspects of the configuration
before the system database is updated with a new project file. MapSense generates
warnings, error messages, and notifications.

Errors

Errors display in red and must be corrected before the project successfully exports.

Warnings

Warnings display in yellow. Although the project will sync with the SynapSoft with
warnings, it is best to ensure that all of the warnings are addressed before export.

Information

The Information tab lists notifications. These are not as urgent as warnings; however,
there may be items that you should address prior to deployment in the data center.

Sync with SynapSoft

See Export to SynapSense Environment Server.
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Locate in Plan

The Locate in Plan button on the export Validate Project dialog provides a link to the
objects on the drawing. When selected, the drawing displays with the object highlighted.
If the object is outside of the current view, the drawing moves to display the object in the
center of the screen. When working on a project with multiple drawings, the selected
item on the Active drawing is highlighted. If the Active drawing contains none of the
selected items, the drawing with the most occurrences of the item displays with the items
centered.

To locate an item in the Drawing, click an item on the Validate Project list, and then click
Locate in Plan.

Refresh

After making changes to rectify the cause of an information, error or warning message,
click Refresh to run the project validation again.

Test Device Expressions
This option, included in the Export drop-down menu, triggers a retest of all devices in a
project after validation. In the latest release of MapSense, there are more conditions that
invalidate the test and require retesting, making it important to simplify the process.

For details, see the Active Control User Manual.
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Sync with SynapSense Environment
Server
Export the project file from an instance of MapSense that is installed on the same server
as the rest of the SynapSense suite of products.

To sync with the Environmental SynapSoft:

1. Ensure all errors listed in Project Validation are fixed.

2. Click Export and select Sync with SynapSoft from the drop-down menu.

3. The Confirm Export dialog box displays if there are any errors or warnings. You
can proceed with the export if there are warnings, but you cannot proceed if there
are errors. Click Yes if you want to proceed despite the warnings.

4. In the Server Login dialog, enter a SynapSense Administrator password.
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5. A message displays to indicate successful export. If an error notification displays,
take steps to remedy the problem and run this export process again.

Note: MapSense caches the credentials during the session so that you don't need to
input the Environmental SynapSoft credentials each time.
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Working with Multiple Drawings in a
Project
Data center facilities come in a variety of configurations and MapSense handles the
myriad of possibilities with a drawing for each data center that can have (where
appropriate) associations between floors or rooms. These drawings are added and
instrumented individually with a background image of the data center layout or no
background image for mapping things like PUE graphs. Most tasks related to configuring
a project are the same whether the data center has one or many drawings. This section
describes what is different when the data center has more than one drawing.

Adding More Drawings to a Project
Add and instrument a new drawing or import an existing MapSense project as a new
drawing in a new project.

To add another drawing:

1. Select Add Drawing from the Project menu.
2. In the Add Drawing dialog, enter a name for the new drawing.
3. Click OK.

Note: Drawings display in alphabetical order.

To import an existing drawings from another project file:

1. Create and save the new project.
2. Select Import Project from the Projectmenu.
3. In the Import Project dialog box, navigate to and select the project file (.dl or .dlz file

extension) to import.
4. Click OK.

To delete a drawing:

1. On the Active Drawing drop down list, select the drawing to delete so it displays in
the Workspace.

2. On the Projectmenu, select Delete Drawing.
3. Click Yes to confirm the deletion.

To add a drawing with no background image:

1. Select Add Drawing from theProject menu or toolbar.
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2. On the Add Drawing dialog,deselect the Set Background Image checkbox.
3. Click OK.

Working with Components across Drawings
With multiple drawings, it is possible to:

l Move a component from one drawing to another in the same project.
l Create proxies to represent a component on one or more drawings
l Split a drawing with two rooms into two drawings with one room each

Note: For both Move to Drawing and Make New Drawing from Selection, a proxy is
automatically created and left in the previous location whenever the moved component
on the original drawing was associated with components that were not moved.

Move to Drawing

1. Highlight the component to move.
2. SelectMove to Drawing on the Edit menu.
3. In the Choose Drawings dialog, select the radio button for the destination drawing.

4. Click OK.

Make New Drawing from Selection

For cases where a single drawing will be divided into more than one room or section,
use the Make New Drawing from Selection feature on the Project menu. This feature
makes a copy of the area selected and automatically creates a new drawing. The
background image remains the same. To change the name, highlight the new drawing
and change the Name in the properties panel.

Using Proxies
Proxies enable the association of two components located on different drawings. The
proxy is a component that exists as a child of one data center component but which has
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no managed objects of its own. It acts as the proxy for a component in another drawing.

Proxies have only five properties: name, x, y, configuration, and description. The proxy
will have the same icon as the component it represents.

Considerations for Multiple Data Centers
When configuring a SynapSense server for multiple data centers or locations, several
projects may be exported into one SynapSense installation. This creates multiple data
centers in the Sites list in the Web Console.

There are several issues to consider when exporting multiple data center projects into
one installation:

Data center names should be unique – This makes the Sites list more usable and helps
you identify each data center accurately.

MAC IDs cannot be duplicated – The same MAC ID cannot be used in different data
centers. This would only happen as a mistake since the same node cannot be installed
on two different racks at the same time.

Names of components across data centers should be unique – It is best to call the
components by different names in different data centers to make them easier to find or
reference. A short prefix designating to which data center a component belongs may
alleviate confusion.
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Additional Configuration Tasks
The following are tasks that can be performed, but are not required, to create a project.

l Exporting Floorplan Images
l Using Project Statistics
l Change View Options
l Find Tool
l Rotate Floor Plan
l Component Libraries

Exporting Drawing Images
MapSense enables you to embed the drawing in other documents using the Export
Image option. There are three options for this export including Export Deployment Plan,
Export Background Image and Export All Images.

l Export Background Image – Exporting the Background Image saves only the
background image (drawing) to a .png file.

l Export Deployment Plan – Export Deployment Plan saves all components in
addition to the background image to a .png file. This is useful for reports or
presentations where configuration and layout details must be documented. Export
Deployment Plan creates a .png file that looks exactly like the image on the
screen. It is rendered exactly the way it appears on the screen. All halos,
association lines, and so forth are shown, including the highlight of any selected
components. The plan can be adjusted by modifying the view options of the draw-
ing.

l Export All Images – Export All Images exports the background image and the
image that MapSense creates for each room. This causes multiple .png files to be
saved to disk.

To export an image of the drawing:

1. Ensure that the screen appears as desired.

2. On the Export menu, select Export Image.

3. Select the export image type.

4. Navigate to location where you want to place the exported file.

5. Click Save.
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Using Project Statistics
Use Project Statistics to assist with ordering equipment from Panduit after the
SynapSense implementation is complete. There is a total of all components used in the
entire SynapSense implementation. Each room has its own subtotals for components
placed within that room. Contact your Panduit representative for more information.

To view project statistics:

On the Project menu, select Project Statistics or Project Statistics by WSN Network. This
provides the number and type of SynapSense nodes for the entire project or by WSN
network, respectively.

Note: The listings do not create separate entries for racks requiring a Reference
Temperature and those that do not. For example, all Rear Exhaust Racks, both with
and without a Reference Temperature requirement, are included in one total.

Change View Options
The manner in which components and other parts of the interface are displayed can be
customized.
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To customize view options:

Select View Options from the View menu. The View Options dialog displays the
following tabs:

l General
l Components
l Halos
l Associations

The following sections describe the set up options within each of these tabs.

General Tab

Use this tab to display or hide the background image and component names. In addition,
the Component Name property can be changed to display MAC ID instead. See the
section Association View Settings for details on association line behavior options.

Components Tab

Use this tab to select the component types to be displayed on the drawing. It does not
remove the components, it only hides them from view and when saving to a .png file.
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Halos Tab

Use this tab to display or hide the Design Assistance Halos for the components that
have halos associated with them, such as Rack components and Pressure components.
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Associations Tab

Use this tab to display or hide the various types of association lines and association
details.

Find Tool
Use this tool to search for components by property name or property value on the draw-
ing. The Find tool is accessible from two locations:

l On the Edit menu, select Find
l Click the Find button on the toolbar

Search for – Use the Search for field to enter a specific value.
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Search in Property Name – Use the Search in Property Name drop down list to
constrain the search results to a specific component property.

Scope – Select the group of items to display.

Entire Project - Includes every item from every drawing in the current DL file.
Active Floorplan shows those items in the currently selected drawing (for projects with
multiple floors or a PUE graph).

Current Selection - displays a list of items selected on the drawing. This is helpful when
changing an object property for one or more components. See Editing a Value.

Locate in Plan – Click Locate in Plan to highlight all of the components on the drawing
that were selected in the search results dialog. MapSense zooms and centers the draw-
ing to display the selected items.

Export to CSV – Export search results to a separate file in comma-separated value
(CSV) format.

Searching Pre-selected Components

The number of items currently selected displays just above the filtered search list in the
Find tool dialog. In the image above, the field “All components in current selection”
indicates that nothing on the drawing was pre-selected prior to opening the Find tool
dialog, and all components are available for searching. If components were selected
prior to opening the Find tool dialog, the message field  would indicate the number of
items selected. For example, if 100 components were selected the text field would show
“100 components in current selection”.

The Search on Selection checkbox constrains the Find tool search to the pre-selected
items.
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Editing a Value

Instead of clicking on every component to change one property value, use the Find tool
to list the components needing the property change. Click the Edit button, then double
click on the value to activate the field and make the change. Click off the field to
deactivate it. The edit button remains active until it is deactivated (clicked again), or until
the Find tool is closed.

Replace Tool

Use this tool to search and replace text strings, either throughout the project or within the
components currently selected.

To replace text strings:

1. In the Find field, enter the string to be located and replaced.

2. In the Replace with field, enter the replacement string.

3. Select the appropriate Scope from the drop down list.

4. Click OK to replace.

Rotate Drawing
Use this feature to rotate a drawing for easier viewing in the Web Console. This feature
rotates the entire drawing and all of the components.
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The figures above shows a drawing in its original orientation, then the same drawing
after being rotated right (clockwise) 90 degrees.

To rotate the drawing:

1. On the Editmenu, select Rotate Drawing 90°Right or Rotate Drawing 90°Left,
then click Yes to continue or No to decline the action. You cannot undo the
rotation.

Rotating a Selection
The Edit menu contains several options for rotating one or more objects. Rotate
Right/Left, Rotate 90˚
Right/Left are straightforward. Rotate Selection Around Center is less so.

To rotate a selection around center

1. With the Selection tool, highlight the group of objects to rotate.

2. Right-click on the object you want to use as the center point.
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3. On the Edit menu, select Rotate Selection Around Center.

4. In the Rotate Selection dialog, enter the degree to which the object should rotate.
For example, 180˚.

5. Click OK.

Component Libraries
A Component Library is a bundle of legacy or customized components that are not part
of the current default installation of MapSense. Once loaded, the additional components
display in the Palette Selection Area.

Previous installations of MapSense used sensor node components that have since been
updated. Panduit may have created one or more customized, data center-specific sensor
node components not included in the basic set. In either case, these sensor node
components are placed by Panduit into a Component Library that is loaded with all the
existing sensor node components.

To load a library:

Note: Only proceed with this task when expressly asked to do so by Panduit Technical
Support or Panduit Professional Services representatives.

1. On the File menu, select Load Component Library.

2. Browse to the Component Library directory on the Installation CD.

3. Select the library (in this case, it is the legacy library).

4. Click Open to add the new components to the Component Palette.
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Maintaining an Existing Project
Once the project is created, it is relatively easy to move and replace components on the
drawing as changes are made in the data center. Make the required changes in
MapSense and export the drawing to the Web Console. The new version will replace the
old without loss of data.

Common maintenance tasks in the data center include replacing and changing sensor
nodes, and changing the location of racks. These physical changes also require
changes to the related MapSense drawing including changes to components and
background image.

Also see:

l Opening an Existing Project
l Making Changes to Components

Opening an Existing Project
There are several ways to open an existing MapSense project. This topic describes
each method.

To open a project stored on the local machine:

1. Open the MapSense application.

2. On the File menu, selectOpen from Disk.

3. Navigate to the location of the project on the local machine.

4. Select the file name then click OK.

To open a project stored on the SynapSense Environment SynapSoft

1. Open the MapSense application.

2. On the File menu, selectOpen from SynapSoft.

3. In the Server Login dialog, type the user name, password, and server name for the
Environment Server.
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4. Click OK.

5. In the Open from Disk dialog, select the project file you want, then click Save &
Open.

6. In the SaveAs dialog, navigate to the location where this file should be saved and
click Save. This action saves a copy of the project to the local machine.

Other ways to open an existing MapSense project

l Double-click on the project file name in Windows Explorer. This automatically
launches the MapSense application and opens the file.

l On the File menu in MapSense, select the name of a recently opened file

Making Changes to Components
This section describes how to replace and swap components, change component name,
add or delete components, and how to change the background image. See also Working
with Multiple Drawings in a Project.

Replacing a Component with One of the Same Type

When a physical sensor node is damaged or becomes unstable and needs to be
replaced, follow these steps within MapSense to replace the component.

1. Open the project file in MapSense.

2. Use the Select tool on the toolbar to select the component that represents the
sensor node to be replaced.

3. Change the MAC ID to that of the new sensor node. For more about MAC IDs, see
the section Assign MAC IDs.
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After the MAC ID is changed, the project must be exported to update the system
configuration. See
Export to SynapSense Environment SynapSoft for more information on exporting a
project.

Replacing a Component with One of a Different Type

As data centers change, different types of components are needed. These steps
describe how to replace an existing component with one of a different type.

To replace a component with one of a different type:

1. Right-click the component and select Replace Configuration from the context
menu.

2. Select the new component type in the dialog box that displays.

3. Select one of the following:

l Replace to completely replace the component.
l Update maintains the historical data when a similar object is selected.

4. Click OK.

WARNING: Selecting Replace deletes all historical data on the server that is
associated with that component.
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Changing a Component Name

This section describes how to change a single component name. If many components
need to be renamed, see the section Name Components for details on how to make the
process faster using the Quick Name tool. After the component is renamed, you must
export the project to update the system database.

1. Select the component to display its properties.

2. Click the Name value in the Properties Editor to activate the field.

3. Type the new name.

4. Click off of the field to deactivate the field.

You can also double-click the component on the drawing to edit the name property.

Moving a Component

To move a component click and drag the component to the new location. If the location
of a rack component is changed, the Reference Temperature for that component may
also need to be changed. The project must be exported to update the system database.

Deleting a Component

To delete a component, select the component then press the Delete key. The project
must be exported to update the system database.

WARNING: Any deleted component permanently loses all of the associated
historical data.

Swapping Components

This enables changing component names without causing any errors and without losing
the historical data from the corresponding sensor nodes.
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1. Enter the MAC ID of Sensor Node 1 into the component representing Sensor Node
2.

2. Enter the MAC ID of Sensor Node 2 into the component representing Sensor Node
1.

3. Export the project to update the system database.

4. Power-cycle both nodes. If the nodes are not power cycled, they will continue to
report into the previous sensor set in the database.

Remove Project from SynapSoft
You can remove a project from the system database so that it is no longer accessible
from the Web Console.

On the Exportmenu, select Remove From SynapSoft, then confirm the deletion in the
message displayed.
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Power Monitoring
This chapter provides the information you need to configure Power Monitoring in
MapSense.

About Power Monitoring
Power Monitoring enables you to optimize loads, reduce stranded power, and identify
both power and space capacity in real-time. Power Monitoring is set up in MapSense
using Power Suite components.

Once configured within MapSense, view data in PowerImaging™ which displays the
power usage, along with the environmental readings for temperature and pressure.

Also see Configuring Power Monitoring.

Configuring Power Monitoring
Power Suite components add power monitoring to your data center. Power Suite
components can be used with their own environmental harnesses or can be used in
conjunction with existing environmental monitoring components.

Note: When installing power monitoring, work with your Panduit representative to
define an appropriate power-monitoring plan. This section describes only the steps to
configure your plan in MapSense.

PUE and Other Calculations
This chapter provides the information you need to work with PUE and other calculations
in MapSense.

About PUE
Power Utilization Effectiveness (PUE) refers to how much of the energy used by a data
center is consumed directly by the IT equipment, compared to the overall amount of
energy used to power and cool the entire data center.
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PUE Formula

PUE = All energy used by DC (including power loss and general lighting) ÷ IT Load

PUE calculations can take data from wireless or wired sensors, as well as other building
management systems. To correctly instrument and design accurate PUE calculations,
knowledge of the electrical one-line drawing and how it is implemented in a facility is
required.

Note: Not all SynapSense platform configurations include sensors to monitor and
provide data for PUE calculations. It is important to have a Panduit partner that is
knowledgeable with large- scale electrical systems help design the PUE calculation
and install the sensors required.

Designing Your PUE Graph
Before creating the PUE graph in MapSense, do the following:

l Prepare the Equipment - Physically equip all power panels, PDUs, transformers,
UPS devices, coolant pipes, or other points of power usage that relate to PUE with
sensors that report kilowatts (kW). (PUE calculations in MapSense are in kW.)

l Draw a diagram of the data flow - Include monitoring points, calculations, and
exclusions. The PUE Graph shown above uses an example of a simple data
center with only one panel for IT power, one for cooling power, a chilled water
energy meter for coolant energy and an equipment status sensor for lighting. More
often, data centers have several panels for each item. There may be circuits for
each panel that should be subtracted from the total panel power usage because
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they go to a resource other than the data center. Coolant fluid calculations are also
complex because coolant pipes often also feed equipment that is not related to the
data center.

l Manually calculate PUE - Use this to double-check the PUE result displayed in
the Web Console.

When finished preparing, create a separate drawing for the PUE graph in MapSense. In
the Web Console, only PUE and Custom Metrics tabs display for this data center.

To create a PUE graph in MapSense:

1. Add a drawing to the data center without a background image.
2. Make proxies for all input components to be used for calculating PUE.
3. Create one or more calculation groups.
4. Create and associate Calculation components on the drawing.
5. Configure Inspectors on the drawing.
6. Export the graph to the Environment Server and troubleshoot in Web Console.
7. Add the PUE Reporter component.
8. Export the design to the Environment Server.

These steps are explained in greater detail in the following sections.

Types of PUE Components

There are three general classes of components used to create a PUE Graph:

Inputs generate data either from an energy meter, other power sensor or an external data
source such as a building automation system. They are inputs into the PUE Graph.
Place proxies on the PUE drawing for each input component on the actual drawing.

Calculation Components take inputs, perform mathematical calculations on them and
provide output to the PUE Graph. These may be as simple as a Summation component
or as complex as a Rated Power Loss component.

Reporters and Inspectors take the data from providers and Calculation components and
generate an output display in the Web Console. The only consumers in a PUE system
are the PUE Reporter and Inspectors. Place one reporter on the virtual floor. Inspectors
are critical for troubleshooting.

PUE Lite requires fewer properties to configure a basic PUE calculation. See your Pan-
duit Professional Services representative for additional information.
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PUE Contribution Categories

PUE is based on four basic categories of data: IT Power, Cooling Power, Lighting and
General Power, and Losses. PUE is the ratio of IT Power to the entire power load of the
facility, but measuring each area separately is useful for investigation. Each area is
described below:

l IT Power Contributions – Power meters or BCMS systems that measure the
feeds to computer or networking equipment.

l Cooling Power Contributions – Chiller plant energy, pumps, CRAH fans, CRAC
compressors and other similar types of power used to cool the data center. This
includes all power associated with the cooling loop. This should also include
cooling power for areas that support the data center such as UPS rooms, MDF
rooms, DC plants, and battery rooms.

l Lighting and General Electrical Contributions – Typically this category is for
non-IT and non-cooling energy usage. Lighting is the most common example.
General electrical plugs around the data center should be put into this category.
This should include lighting and general receptacles in the same support areas
mentioned under cooling.

l IT Power Losses – Losses across power conversion equipment, such as UPS
devices, transformers and PDUs. Separate components are provided to calculate
the loss based on whether the load is metered before or after the transformer.
However, it is always best to directly measure the load before and after power
conversion equipment.

The PUE Graph is a series of calculation operations that aggregates each of these
categories, and then calculates the final PUE. Since data centers may have complex
power distribution systems, many calculations may be required to aggregate each
category.

Creating a Calculation Group

A calculation group is a grouping to which the PUE components are added. Sensor
components, like Racks and Gateways, reside in rooms, but they can also be linked to
PUE components in a calculation group.

Multiple calculation groups can be added to a project file. Multiple calculation groups are
often useful for organizing energy data into categories (for example, loss, IT load,
cooling load, general).

Note: Use at least one Calculation Group per PUE category. Panduit recommends
creating four calculation groups which match the four types of PUE (IT, Losses,
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Cooling, and Lighting/General). This makes it easier to troubleshoot the calculations
and to run reports from the Data Analysis tool in the Web Console.

To create a Calculation Group:

1. Ensure that the user level is set to Advanced.
2. Select Add Calculation Group from the Groupings menu, or click the Add Cal-

culation Group icon.
3. Enter a unique name and use the Active Grouping drop-down list to select it as

the current calculation group. View the newly added calculation group in the
Groupings tab on the right side of the user interface.

4. Repeat Steps 1 to 3 to add more Calculation Groups – one for each type of PUE
category.

Creating and Associating Calculations

PUE graphs may require calculations to be performed prior to input to the PUE Reporter.
Most PUE Graphs require calculations be performed on sensor inputs before they can
be properly used as   inputs to the PUE Reporter component. For example, if there is a
circuit on a panel that feeds a load unrelated to the data center, then two power meters
would be required; one to measure the total power of the panel and the other to measure
the power used by the unrelated circuit (to be subtracted from the total).

There are a variety of components available for performing math operations on incoming
values from power or calculation components. Each performs a specific math function,
such as addition, subtraction, multiplication, square root, and so forth. These
components can be strung together in series and parallel to perform complex
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mathematical calculation on values to provide the Web Console (via the PUE Reporter)
with valuable information on energy flow and usage within the data center.

Note: Some of the specific calculations and their uses are reviewed in the section, Spe-
cific Components.

For each component, the Properties Editor panel displays the selected operation. All
associations are created in the same method, shown as follows.

To associate Calculation Components

1. Click the Select tool from the toolbar and drag the selection cursor over the
components.

2. Right-click over a Calculation component to associate. The Associations dialog
appears.

3. Select the type of calculation from the drop down list.
4. Repeat Steps 1 to 3 as necessary.

Note: It is important to choose the correct connections. For example, be careful not to
include the loss from one calculation in with the addition calculation that will eventually
be associated with the IT load.

Configuring Inspectors

Add Inspector components to the drawing. Inspectors enable you to troubleshoot a PUE
graph. Inspectors are the only way to see calculation data in the Web Console.
Inspectors are also used to visualize data that cannot be viewed any other way, or to
create a custom metric for the data center.

Select the Inspector component from the Palette then click on the component (on the
drawing) to which you want the inspector attached. The Inspector automatically
prepends the name of the component to which it is attached.
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Export and Troubleshoot

Verify that the PUE Graph is correct by exporting and troubleshooting the calculations
and associations as created up to this point. Exporting enables you to clarify errors (that
is, troubleshoot) prior to using the PUE reporter, which is active and starts recording
history immediately upon adding it to the drawing.

Once the file is exported and data is flowing into the various calculation objects, this data
can be viewed in the Custom Metrics tab in the Web Console. This tab only becomes
active once there are objects with inspectors exported. The data for each object with an
inspector can be viewed in tabular and chart format in this tab. Enter the data into a
spreadsheet to validate that calculations are correct and the PUE is as expected.

Adding the PUE Reporter Component

The PUE Reporter component is the central piece of the PUE Graph. This component
causes the Web Console to show the PUE tab for a particular data center. It accepts four
inputs (loss, IT load, cooling load, and lighting/general). The PUE Reporter component
calculates inputs in kilowatts (kW). Those inputs typically come either from other
calculations or directly from meters. It performs the PUE calculation for display on the
PUE tab. All calculations need to be associated to the PUE Reporter component for data
to display on the Web Console.

To add a PUE Reporter component:

1. Select the PUE category on the Palette Tree and select the PUE Reporter
component.

2. Click to place the PUE Reporter component. This component does not display on
the physical drawing tab in the Web Console so you can place it anywhere on the
drawing. However, for troubleshooting purposes, it is recommended that all of the
elements in the PUE graph be placed so that the layout is easy to follow.

Only one of these components can be placed in a data center design. If
additional PUE Reporter components are placed in a project, an error is
generated during export.
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3. Enter the values for IT Power Design, Baseline PUE, and Cooling Power Design
in the Properties Editor panel for the PUE reporter. The CO2 Emissions property is
also required. Find the information listed by location in a Department of Energy
document entitled “Voluntary Reporting of Greenhouse Gases” on the web at
http://www.eia.gov/oiaf/1605/pdf/Appendix%20F_r071023.pdf. The project file
cannot be exported without these values populated.

l IT Power Design is the theoretical maximum power available for IT load. It is
typically calculated by adding up all of the kW capacity of the UPS devices and
applying an 80 percent safety factor. This value is used to calculate the percent
utilization of IT power in the data center.

l Baseline PUE is entered so that the user can see what effects improvements in
the data center make in the PUE number.

l Cooling Power Design is calculated from the theoretical capacity of the chiller
plant and all of the fans. It is used by the system in the same manner as IT Power
Design.

Exporting the PUE Design

After all metered points, manual inputs, Inspectors, and Calculations have been
configured and connected to the PUE Reporter, the PUE drawing is ready to be
exported to the Environment Server. See the section, Export to SynapSense
Environment Server for more information.

Note: Verify that the PUE Graph output is correct by manually performing the same
calculations as are used by the Calculation components in the design.

Specific Components

This section reviews some common calculation components, which includes Inlets and
Outlets, Rated Power Loss, and Equipment Status (conditional) calculations.

Note: A detailed description of all the components (including 3-Phase Current to kW,
Absolute Value, and Less-Than Filter) is explained in the MapSense Component

http://www.eia.gov/oiaf/1605/pdf/Appendix F_r071023.pdf
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Libraries. Wired Integration components are explained in that reference document, as
well.

Extending PUE Calculations across Projects

PUE is calculated per floor, and is saved in a project file; however there may be cases
where PUE needs to be calculated across projects. The Inlet and Outlet components
enable a single PUE Reporter to be placed in a single project, but pull information from
other calculations in other project files.

l Outlets – A calculation component that can be attached to any other calculation
value, which makes that value available to any Inlet on the server. It has the
‘power’ consumer type. The Outlet can connect to any single calculation producer
in a project file. The Outlet consumes the value (much like an Inspector) and
makes it available for Inlets to use.

l Inlet – A calculation component that can have any other calculation component
associated with it. To use it, enter the name of the Outlet from which you want to
draw calculations. MapSense finds that outlet, regardless of which data center or
project file it is in, and finds the Inlet with the current value of the specified Outlet. It
has the ‘power’ producer type. The Inlet’s producer can be connected to any
number of other calculations consumers in a project file, allowing them access to
the value that the Inlet has copied form an Outlet. Any number of Inlets can
reference the same Outlet.

There may be cases where PUE is calculated for the entire building. Use the Inlets and
Outlets to access the calculations from several project files to implement PUE across an
entire building. To do this, ensure that an Outlet is added to the first drawing. Then, in the
second drawing, use an Inlet.

Note: It is critical that the name of the Outlet in the other project files exactly the same
name as the name in the properties panel for the Inlet on this project file.

Calculating PUE for Multiple Locations

PUE can be calculated for multiple locations. This is useful in co-location situations
where you want to compute the percentage of cooling costs associated with each IT load
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at a separate location.

Set up the calculations for each of the locations in the project file with the cooling loads.

An example of a metric that can be used would be dividing the total IT load of each co-
locations into the total cooling load of the building, minus some overhead factor.

Rated Power Loss Components

Rated Power Loss components are designed to save a series of calculations that are
typically performed many times when calculating PUE. These components can be used
for any electrical device that converts power from one form to another. The most common
usages are UPS devices or transformers.

l Rated Power Loss (Input) – Simulates a piece of equipment with a rated power
loss where the only known value is the input (primary) power. The component
accepts an Efficiency Table then calculates output power and power loss. This
component has one ‘value’ input, one ‘value’ output and a configurable table.

l Rated Power Loss (Output) – Simulates a piece of equipment with a rated power
loss (such as a UPS or transformer) where the only known value is the output
power. The component accepts an Efficiency Table from the user and then
calculates the input power and power loss. This component has one ‘value’ input,
one ‘value’ output and a configurable table.

To configure Rated Power Loss components:

1. Select the correct Rated Power Loss components for the situation. Usually, only
the input side or the output side is metered.

2. In the Properties Editor panel, click the Efficiency property to display the Efficiency
dialog.
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3. Enter the efficiency curve from the rated power loss specifications for the device.
There are 10 divisions available, but only two are required to draw a straight line.

4. Click OK.

If the electrical device has the same efficiency rating across its entire operating range,
then only two points need to be entered (in any two of the % Efficiency boxes).

Once the efficiency curve is entered, the Rated Power Loss component can then be
linked to the PUE Reporter or other component. The figure above shows the types of
connections and data that can be sent to other components. The most common are loss
and power.

Conditional Calculations (Equipment Status)

Equipment Status Calculations are conditional calculations. Most PUE graphs require
conditional inputs into the PUE calculation. The conditional calculation components are
shown below.

l Fixed Value Switch – Used when an energy meter is not attached to a load, but
there is an equipment status sensor attached. The default value is output when the
equipment status sensor is ‘off’, and the fixed value is output when the equipment
status sensor is ‘on’.

The Fixed Value Switch component can be used for lighting circuits. No
meter is necessary because the load is fixed. The fixed load only needs to be
measured once and then included in  the PUE calculation at times when the
circuit is energized (the default value can be set to ‘0’, to be the output when
the lighting is ‘off’). This component has one Boolean input and one ‘value’
output.

l Input Value Switch – Accepts a connection from a power meter or calculation and
will output that value only when a separate Equipment Status sensor input reports
that the equipment is ‘on’. Otherwise it outputs the default value (normally set to
‘0’). This component has one Boolean input, one ‘value’ input and one ’value’
output.
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l Status Inverter – Normally used after an equipment status sensor to reverse its
Boolean output. Outputs the opposite Boolean value from its input (if ‘1’ is input
then ‘0’ is output, and if ‘0’ is input then ‘1’ is output).
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Appendix A: Functions and Hotkeys
Perform various MapSense functions faster using the key assignments listed in the table
below.

MapSense Tools Hotkey Assignments
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Appendix B: Create Background Images
Note: This Appendix pertains to users who plan to create a background image outside
of MapSense for use in generating a room drawing.

The background image illustrates the floor plan of the data center being monitored.
Background images are created using third-party software and are rendered in PNG
format (.png file). Drawings should include racks, CRAHs, PDUs, walls, doors, and floor
tile lines. Later, it will be necessary to know which side of each rack is the cold air intake.

The background image is usually derived from data center architectural drawings,
typically in AutoCAD® or Visio® format. Both of those programs have the ability to save
images as a .png file.

Before a background image is inserted into the MapSense project, it must have
transparent areas strategically added to it. Transparent areas are where the
LiveImaging™ colors through the drawing. In the example below, only the area around
the racks was made transparent. The area where the  desks are located is opaque and
does not have LiveImaging coloration. Any portion of the data center that does not have
sensors installed should not be made transparent.
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The racks themselves are also not made transparent. This is a practice that Panduit
Professional Services uses because the true temperature of the servers inside each rack
is not known by the system. As a rule, areas six feet (two meters) or more away from the
last sensor on an edge should not be made transparent.

Creating a Transparent Area

Create a transparent layer in a graphic image with an image-editing program. The
example below uses an Open Source product called GIMP (GNU Image Manipulation
Program).

1. Start the image-editing program.

2. Open the image file requiring transparent areas by selecting File from the menu,
then Open.

3. Add an alpha channel to the image (alpha channel is another term for a
transparent layer). To do this, open the task drop-down list on the map window.
Select Transparency from the Layer menu. Then, select Add Alpha Channel. If the
Add Alpha Channel selection is grayed, then the alpha channel already exists.

4. On the GIMP tool window, click the Select by color tool button.

5. Click the area on the map to be made transparent inside an area of color to
become transparent. This is typically colored white. Jagged lines indicate that all
the white areas on the image have been selected.
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6. The next step is to deselect all of the areas that should not become transparent.
These should include all of the racks, CRAHs, furniture, and areas outside the
room walls. Deselect any rooms contained by the data center that do not have
sensors (for example, stairwells), as well as equipment like PDUs and tape backup
units. Click the Rectangle Select button on the GIMP tool window.

7. Click the Deselect Mode button in the GIMP tool window near middle of the
window (third icon from left).

This is the area to subtract from the transparency color previously
selected in Step 4.

8. Use the mouse to create non-transparent boxes over the items described in Step 6
until complete. Mistakes can be undone by selecting Undo from the Edit menu.
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Note the selection box over the area of the drawing with the desks, which prevents
that area from becoming transparent.

9. When all areas are complete, press Delete on the keyboard. This removes all of
the white areas still selected from Step 5.

10. Save changes with Save As under a new name (for example, append “trans” to the
end of the file name). This ensures that the original (non-transparent) image
remains intact.
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Appendix C: Scan MAC IDs
The Scan MAC IDs dialog, displays a list of the items in the project that require MAC IDs
by product type. For example, if you are adding two Gateways and 100 ThermaNode EZ
products, those would be listed in groups, first the Gateways, then the ThermaNode EZs.
The user scans the number of items per product type. Once the MAC IDs are scanned,
validate the list and correct any errors, then export and save the file.

To scan MAC IDs:

1. Open the MapSense application.

2. On the File menu, selectOpen from Disk to display the project file (.dlz) you want
to work with.

3. On the MapSense Project menu, select Scan MAC IDs.
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4. When the Scan MAC IDs dialog displays, select the Drawing and WSN network
from the drop-down lists. The default is the active drawing.

5. Scan the MAC IDs for each type of product in the order displayed on the list.

6. Click Validate to check for errors.

7. Click Hide Valid MAC IDs to display only those items with errors; those with empty
MAC ID cells, Bad Checksum, or Platform Mismatch.

8. Click Export Names to create a Labels file in the appropriate location on your
network. Export Names exports those items currently displayed. To export the
entire list, ensure the Hide Valid MAC IDs filter is deselected.

9. Click OK to close the dialog.

Repeat this process for each WSN network.
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